Excel 2013 & 2016: Creating an Accessible Excel Spreadsheet, Part 1

Contents
Excel 2013 & 2016: Creating an Accessible Excel Spreadsheet, Part 1 ................................................. 1
  Introduction ................................................................................................................................................ 2
Common-Sense Practices in Excel .................................................................................................................. 2
  Visual Contrast ............................................................................................................................................. 2
  No empty rows or columns; No merged or split cells .............................................................................. 2
  Worksheet Names and Table Titles ............................................................................................................ 2
  Row and Column Headers ......................................................................................................................... 3
  No Blank Data Cells .................................................................................................................................. 3
  Start Information in A1 ............................................................................................................................... 3
  Hyperlinks ................................................................................................................................................... 4
  Remove Comments .................................................................................................................................... 4
  Set Print Area ............................................................................................................................................ 5
  Hide Unused Rows and Columns ............................................................................................................... 5
  Delete Unused Worksheets ......................................................................................................................... 6
  Staying In the Grid ..................................................................................................................................... 6
  Check Spelling .......................................................................................................................................... 6
  Document Properties ................................................................................................................................. 6
  End of Worksheet ...................................................................................................................................... 8
  Before Saving the File ............................................................................................................................... 8
To summarize .................................................................................................................................................. 9
Introduction
Many of the things we need to do to make an accessible spreadsheet in Excel are good practice anyway. This module covers those practices. We also need to do some specific things for visually impaired users, including those who use screen readers. The next module, Accessible Excel Spreadsheets Part 2, focuses on specific practices for screen readers.

If you are making forms in Excel, you should also watch Accessible Excel Forms Parts 1 and 2.

Common-Sense Practices in Excel
These practices make your spreadsheets more accessible, but they also make them more easily usable for everyone.

Visual Contrast
The easiest way to provide good visual contrast is just to leave the whole workbook in black and white. If you need color for some reason, refer to the Word module about Contrast for ways to be sure there is adequate contrast for all types of readers.

No empty rows or columns; No merged or split cells
On each worksheet, the information should start in cell A1. It should extend right and down from there without skipping any rows or columns. If you need space between areas to assist sighted users to navigate the worksheet, increase the row height or column width.

Except for the titles above tables, as described below, don’t merge or split cells.

Worksheet Names and Table Titles
Provide a descriptive name for each worksheet in your workbook, and a descriptive title for each area of your worksheet that is formatted as a table.

1. To change the name of a worksheet, double-click on the name in the tab at the bottom and type in a new name. Worksheet names must be between one and 31 characters long. The special characters colon, slash, backslash, question mark, asterisk, and left and right square brackets are not allowed.

![Worksheet Name](image)

2. Give each table a descriptive title that explains what information it contains. The title should be in one or more rows directly above the table, and should start in column A. For example, instead of the title, “Project Plan,” use a title that will tell the reader five years from now what the table is about, such as, “Office 2013/2016 Accessibility Training Module Timeline, Summer 2016.”
3. If you want to center your title above the table, select the cells in the title row corresponding to the width of the table. In the Format Cells dialog, select the Alignment tab. Check the Merge Cells box, and in the Horizontal alignment drop-down, select Center.

**Row and Column Headers**

Each table should have row and column headers for every column and every row in a way that makes sense. Don’t leave any headers blank, even if the meaning seems obvious to you. Column headers should occupy just one row.

**No Blank Data Cells**

Cells should not be left blank. If the cell really has no data, then you can put in: “This cell intentionally left blank” or “No data.”

**Start Information in A1**

A screen reader starts reading any sheet in cell A1. If you have a table on the sheet, A1 may simply be the title for the table. If the sheet is long or complex, add instructions or an overview in A1. When visual users first open a spreadsheet, they get an immediate sense of what is on the sheet. Having a short sentence or two in A1 will give screen reader users the same quick overview. The text can say
“This sheet contains 3 data tables” or “This sheet contains one chart and 2 tables” or “This sheet has 1 long table with 500 rows grouped by department.”

**Hyperlinks**

Ensure that all hyperlinks work. Show a working URL, and add a ScreenTip.

To access the Hyperlink dialog box, Right-Click on the cell and choose Hyperlink (if there isn’t a hyperlink yet) or Edit Hyperlink (if there is already a hyperlink in that cell).

1. Place the full URL in the Address box. Leave the Text to Display box blank, so the URL will display in the spreadsheet. This allows those who print the spreadsheet to access the link.

![Edit Hyperlink Dialog Box]

2. Add a ScreenTip, using the ScreenTip button in the upper right. Describe what the link leads to. ScreenTips appear when you mouse over the link, and are readable by screen readers.

![Set Hyperlink ScreenTip]

**Remove Comments**

Remove comments before publishing (such as those you used during peer review). Screen readers can’t read these, so if the information is important to your audience, put it in a cell.

To remove a comment, select the cell containing the comment. Right-click, and choose **Delete Comment**.

We’ll discuss a “pop-up” alternative to comments in the Excel Forms module.
Set Print Area
1. Highlight the entire area of the worksheet that includes any information.
2. In the **Ribbon**, select the **Page Layout** tab.
3. In the **Page Setup** group, under Print Area, select Set Print Area.

To hide columns:
1. Select the first blank column to the right of your data. Holding down **Shift** and **CTRL** keys, press the **right arrow** key.
2. Right-click in the selected area and choose **Hide**.

To hide rows:
1. Leave one blank row below your data, then select the next row below that. Holding down **Shift** and **CTRL**, press the **down arrow** key.
2. Right-click in the selected area and choose **Hide**.

If you need to unhide these cells later:
1. Select the last visible row or column. Still holding down the mouse button, drag into the hidden area. The area selected, including the hidden cells, will be shown next to the cursor.
2. Right-click in the last visible row or column, and select Unhide.

A screen reader will not read hidden cells, so if you hide a cell from sighted users, you hide it from screen-reader users also.

**Delete Unused Worksheets**

To delete an empty worksheet, right-click on the tab of the unused worksheet and choose **Delete**. Confirm by selecting **Delete** in the dialog box that pops up. Be careful, because this cannot be undone.

![Microsoft Excel message box](image)

**Staying In the Grid**

Information located in the grid of worksheet cells is accessible to a screen reader user in the correct reading order. Information floating on top of the grid of cells, such as text boxes, charts, and images, is not accessible in the correct reading order.

Floating content such as text boxes, charts, and images will be announced as “Embedded objects” when a sheet is first opened with a screen reader. If the object has alt text, it can be read by a screen reader, but the screen reader cannot tell where in the grid the object is located or what it may refer to in the grid.

Instead of a text box, put text in a cell. You will have to design the worksheet so that the text will be read in a reasonable order with respect to the other information it refers to.

For images and charts, the alt text will have to explain the relationship of the image or chart to the other information on the sheet. Instructions on adding alt text are in the second module on Excel in this series.

**Check Spelling**

Be sure to do a spell-check on each worksheet. Excel doesn’t put a wavy red line under a word it thinks is misspelled, and it will only spell-check one worksheet at a time.

1. In the **Review** tab, in the **Proofing** group, select **Spelling**, and follow the prompts.

![Excel Proofing group](image)

**Document Properties**

Fill out the **Document Properties** following your agency’s standards. This provides background information on the workbook for those reviewing it later, and assists search facilities on web sites or
other document repositories. Take care to note information that should be omitted for security or privacy reasons, as well as information that should be included.

Click the **File** tab, and choose the **Info** tab on the left. On the right side there is a frame listing the properties.

You may edit the properties directly here, or use the drop-down menu by the word Properties. Select **Advanced Properties**.

Select the **Summary** tab, and enter the information in the form.
End of Worksheet
Add “End of Worksheet” in column A after the last row of data on each worksheet. This tells screen reader users that there is nothing further, and they can move on without wasting time. Some people prefer to make the text invisible to sighted users by making the text white on a white background.

Before Saving the File
When you save a file, Excel remembers the last sheet you were working on, and the last cell selected on each sheet. So that screen readers will begin in the A1 cell on each sheet, select that cell before you save the file. Similarly, if you want users to begin at the A1 cell on the first sheet, save the file with that cell selected.
To summarize

We discussed:

1. Using good visual contrast
2. Avoiding empty rows or columns
3. Formatting without merged or split cells
4. Providing descriptive titles, row and column headers
5. Not leaving unnecessary blank cells
6. Starting in cell A1
7. Making accessible hyperlinks
8. Omitting comments
9. Setting the Print Area
10. Hiding extra Rows and Columns
11. Deleting unused worksheets
12. Keeping information in the grid, and handling alt text for floating elements
13. Performing a spell check
14. Filling out the Document Properties
15. Marking the end of the worksheet
16. Saving the file with the starting points selected

If you follow these steps you’ve made a good start toward an Excel spreadsheet that will be easy to understand for everyone, and will also be accessible to those using assistive technologies. For complete training continue with the additional Excel modules.